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W
ell, welcome to the latest version of the Autodesk® 3ds Max® 2013 software, and the first question 
on the minds of existing users is, “Did the interface change?” The answer is a happy “very little.” 
Most serious users would rather go through root canal surgery than have their user interface (UI) 

change, and Autodesk has learned and respected this valued opinion by keeping the interface changes to 
a minimum.

As you look around the new interface, you’ll see that everything is still there, but that 3ds Max has a few 
new additions. You may find yourself saying, as you navigate the interface, “Where did that come from?” 
But, just like encountering a new house in your neighborhood, over time you’ll become accustomed to the 
addition and may even meet some new friends.

Why is the software interface so important? Well, consider this: The interface is the set of controls that 
enable you to access the program’s features. Without a good interface, you may never use many of the 
best features of the software or you may spend a frustrating bit of time locating those features. A piece of 
software can have all the greatest features, but if the user can’t find or access them, then the software 
won’t be used to its full potential. 3ds Max is a powerful piece of software with some amazing features, 
and luckily the interface makes these amazing features easy to find and use, but the interface can be a lit-
tle daunting to new users.

The interface’s purpose is to make the software features accessible, and in 3ds Max you have many differ-
ent ways to access the features. Some of these access methods are faster than others. This design is inten-
tional because it gives beginning users an intuitive command and advanced users direct access. For 
example, to undo a command, you can choose Edit ➪ Undo (requiring two mouse clicks), but as you gain 
more experience, you can simply click the Undo icon on the Quick Access toolbar (only one click); an 
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expert with his hands on the keyboard can press Ctrl+Z without having to reach for the mouse at all. 
All three of these methods have the same result, but you can use the one that is easiest for you.

Has the 3ds Max interface succeeded? Yes, to a degree, but like most interfaces, it always has room for 
improvement, and we hope that each new version takes us closer to the perfect interface (but I’m still 
looking for the “read my thoughts” feature). Autodesk has built a loophole into the program to cover 
anyone who complains about the interface—customization. If you don’t like the current interface, you 
can change it to be exactly what you want.

This chapter examines the latest incarnation of the 3ds Max interface and presents some tips that 
make the interface feel comfortable, not cumbersome.

NOTE

When 3ds Max starts, the default color scheme uses dark gray colors with white text. Although this scheme works great for 

artists who stare at a computer monitor for long periods of time with little or no background light, it isn’t the ideal setting 

for printing. All the figures in this book use the alternate lighter gray color scheme. You can easily switch between the differ-

ent color schemes using the Customize ➪ Custom UI and Defaults Switcher menu command.

Learning the Interface Elements
If you’re new to the 3ds Max interface, the first order of business is to take a stroll around the block 
and meet the neighbors. The interface has a number of elements that neatly group all the similar com-
mands together. For example, all the commands for controlling the viewports are grouped together in 
the Viewport Navigation Controls found in the lower-right corner of the interface.

NOTE

If all the details of every interface command were covered in this chapter, it would be an awfully long chapter. So for those 

commands that are covered in more detail elsewhere, I include a cross-reference to the chapter where you can find their 

coverage.

The entire interface can be divided into six easy elements. Each of these interface elements, in turn, 
has groupings of sub-elements. The six main interface elements are listed here and shown separated in 
Figure 1.1:

• Title bar and menus: This is the default source for most commands, but also one of the most 
time-consuming interface methods. The title bar and menus are found along the top edge of 
the 3ds Max window.

• Toolbars: 3ds Max includes several toolbars of icon buttons that provide single-click access to 
features. These toolbars can float independently or be docked to an interface edge. The main 
toolbar and the Viewport Layout toolbar are visible by default.

• Modelingribbon: Located under the main toolbar, the Modeling ribbon provides quick access 
to the polygon modeling features, including the Graphite Modeling Tools. It is populated with 
panels, buttons, and menus when a modeling object is selected.
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• Viewports: Four separate views into the scene show the scene from different points of view 
including Top, Front, Left, and Perspective.

• Command Panel: The major control panel located to the right of the four viewports, it has 
six tabbed icons at its top that you can click to open the various panels. Each panel includes 
rollouts containing parameters and settings. These rollouts change, depending on the object 
and tab that is selected.

• Lowerinterfacebar: Along the bottom edge of the interface window is a collection of miscel-
laneous controls for working with animations and navigating the viewports.

NEW FEATURE

The Viewport Layout toolbar is new to 3ds Max 2013.

FIGURE 1.1

3ds Max includes six main interface elements.

Title bar and menus

Main toolbar

Modeling ribbon

ViewportsViewport Layout toolbar

Lower interface bar

Command Panel
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In addition to these default elements are several additional interface elements that aren’t initially vis-
ible when 3ds Max is first loaded. These additional interface elements include the following:

• Floating toolbars: Several additional toolbars are available as floating toolbars. You access 
them by choosing Customize ➪ Show UI ➪ Show Floating Toolbars or by selecting them from 
the main toolbar’s right-click pop-up menu.

• Quad menus: Right-clicking the active viewport reveals a pop-up menu with up to four panes, 
referred to as a quad menu. Quad menus offer context-sensitive commands based on the object 
or location being clicked and provide one of the quickest ways to access commands.

• Caddy settings: When modeling, you can open Caddy settings. This group of settings floats in 
a simple dialog box near the current selection and offer several settings that are immediately 
updated in the viewport.

• Dialog boxes and editors: Some commands open a separate window of controls such as the 
Array dialog box or the Material Editor. These dialog boxes may contain their own menus, 
toolbars, and interface elements. 

Using the Menus
The pull-down menus at the top of the 3ds Max interface include most of the features available in 3ds 
Max and are a great place for beginners to start. Several of the menu commands have corresponding 
toolbar buttons and keyboard shortcuts. To execute a menu command, you can choose it from the 
menu with the mouse cursor, click its corresponding toolbar button if it has one, or press its keyboard 
shortcut. 

The main menu includes the following options: Application Button, Edit, Tools, Group, Views, Create, 
Modifiers, Animation, Graph Editors, Rendering, Customize, MAXScript, and Help. Unlike some other 
programs, these menu options do not disappear if not needed. The list is set, and they are always 
there when you need them.

The File menu commands are located under a button that displays the 3ds Max logo. This is called the 
Application Button. Some of the more common commands have been located on the Quick Access tool-
bar for quick access, as shown in Figure 1.2.

FIGURE 1.2

The 3ds Max title bar includes the Application Button, the Quick Access toolbar, and the 
InfoCenter toolbar.

Application button

Quick Access toolbar InfoCenter toolbar

If a keyboard command is available for a menu command, it is shown to the right of the menu item. If 
an ellipsis (three dots) appears after a menu item, that menu command causes a separate dialog box to 
open. A small black arrow to the right of a menu item indicates that a submenu exists. Clicking the 
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menu item or holding the mouse over the top of a menu item makes the submenu appear. Toggle menu 
options (such as Views ➪ Show Ghosting) change state each time they are selected. If a toggle menu 
option is enabled, a small check mark appears to its left; if disabled, no check mark appears.

You also can navigate the menus using the keyboard by pressing the Alt key by itself. Doing so selects 
the Edit menu, and then you can use the arrow keys to move up and down and between menus. With 
a menu selected, you can press the keyboard letter that is underlined to select and execute a menu 
command. For example, pressing and holding down the Alt and then E (for Edit) and then pressing U 
(for Undo) executes the Edit ➪ Undo command; or you can press Alt, use the down arrow to select the 
Undo command, and press the Enter key.

TIP

By learning the underlined letters in the menu, you can use the keyboard to quickly access menu commands, even if the 

menu command doesn’t have an assigned keyboard shortcut. And because you don’t need to stretch for the Y key while 

holding down the Ctrl key, underlined menu letters can be faster. For example, by pressing and holding Alt, then pressing 

the G, and U keys successively, you can access the Group ➪ Ungroup menu command. The keyboard buffer remembers the 

order of the letters you type regardless of how fast you key them, making it possible to quickly access menu commands 

using the keyboard. Over time, you can learn patterns to help you remember how to access certain menu commands, such 

as Alt, C, H, E for creating an ellipse.

Not all menu commands are available at all times. If a menu command is unavailable, then it is grayed 
out, as shown in Figure 1.3, and you cannot select it. For example, the Clone command is available 
only when an object is selected, so if no objects are selected, the Clone command is grayed out and 
unavailable. After you select an object, this command becomes available.

FIGURE 1.3

All menus feature visual clues.

Keyboard shortcut

Submenu exists

Opens dialog box

Disabled command
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TIP

If you right-click the menu bar, you can access a pop-up command to hide the menu bar. If you accidentally dismiss the 

menu bar, you can recover it clicking on the menu arrow located at the right end of the Quick Access toolbar and choosing 

the Show Menu Bar command.

Using the Toolbars
Now that you’ve learned the menu two-step, it is time for the toolbar one-step. The main toolbar 
appears by default directly under the menus at the top of the 3ds Max window. Using toolbars is one 
of the most convenient ways to execute commands because most commands require only a single 
click.

Docking and floating toolbars
By default, the main toolbar is docked along the top edge of the interface just below the menus, but 
you can make any docked toolbar (including the main toolbar) a floating toolbar by clicking and drag-
ging the two vertical lines on the left (or top) end of the toolbar away from the interface edge. After 
you separate it from the window, you can resize the floating toolbar by dragging on its edges or cor-
ners. You can then drag and dock it to any of the window edges or double-click the toolbar title bar to 
automatically dock the toolbar to its latest docked location. Figure 1.4 shows the main toolbar as a 
floating panel.

If you right-click any floating toolbar away from the buttons, you can access a pop-up menu that 
includes options to dock or float the current toolbar, access the Customize User Interface window, or 
show or hide any of the toolbars or the Command Panel. The main toolbar can be hidden and made 
visible again with the Alt+6 keyboard shortcut toggle.

FIGURE 1.4

The main toolbar includes buttons and drop-down lists for controlling many of the most popular 
3ds Max functions.

If you select the Customize ➪ Show UI ➪ Show Floating Toolbars menu command, several additional 
toolbars appear. These are floating toolbars. You also can make them appear by selecting them indi-
vidually from the toolbar right-click pop-up menu. These floating toolbars include Viewport Layout 
Tabs, Axis Constraints, Layers, Extras, Render Shortcuts, Snaps, Animation Layers, Containers, MassFX 
Toolbar, and Brush Presets.

The Quick Access toolbar and the InfoCenter toolbar, located on the title bar at the top of the inter-
face, don’t act like the other toolbars and cannot be pulled away from the title bar.
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Using tooltips and flyouts
All icon buttons (including those found in toolbars, the Command Panel, and other dialog boxes and 
windows) include tooltips, which are identifying text labels. If you hold the mouse cursor over an icon 
button, the tooltip label appears. This feature is useful for identifying buttons. If you can’t remember 
what a specific button does, hold the cursor over the top of it and the tooltip gives you its name.

All toolbar buttons with a small triangle in the lower-right corner, such as the Rectangular Selection 
Region button, are flyouts. A flyout is a single toolbar button that expands to reveal additional but-
tons. Click and hold on the flyout to reveal the additional icons, and drag to select one. Figure 1.5 
shows the flyout for the Align button on the main toolbar.

FIGURE 1.5

Flyout menus bundle several toolbar buttons together.

Flyout menu

NOTE

The General panel of the Preference Settings dialog box contains an option for setting the number of milliseconds to wait 

before the flyout appears.

Using the Quick Access toolbar
Located next to the Application Button on the title bar is the Quick Access toolbar. This mini toolbar 
includes icons for the following commands: New Scene, Open File, Save File, Undo Scene Operations, 
Redo Scene Operations, and Project Folder. A drop-down list also allows you to change the Workspace 
layout. If you click the down-arrow icon on the right end of the toolbar, you can access a menu with 
options to hide any one of the icons or the menus. You also can select to show the toolbar beneath 
the Ribbon.

Learning the main toolbar
On smaller-resolution screens, the main toolbar is too long to be entirely visible. To see the entire 
main toolbar, you need to set your monitor resolution to be at least 1280 pixels wide. To scroll the 
toolbar to see the end, position the cursor on the toolbar away from the buttons, such as below one of 
the drop-down lists (the cursor changes to a hand); then click and drag the toolbar in either direction. 
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Using the hand cursor to scroll also works in the Command Panel, Material Editor, and any other place 
where the panel exceeds the given space.

TIP

The easiest way to scroll the main toolbar is to drag with the middle mouse button because you can click anywhere on the 

toolbar and drag.

Toolbar buttons that open dialog boxes such as the Layer Manager, Material Editor, and Render Setup 
buttons are toggle buttons. When the dialog box is open, the button is highlighted, indicating that 
the dialog box is open. Clicking a highlighted toggle button closes the dialog box. Corresponding 
menus (and keyboard shortcuts) work the same way, with a small check mark appearing to the left of 
the menu command when a dialog box is opened.

Table 1.1 lists the controls found in the main toolbar. Buttons with flyouts are separated with 
 commas.

TABLE 1.1 Main Toolbar Buttons
Toolbar Button Name Description

Select and Link Establishes links between objects.

Unlink Selection Breaks links between objects.

Bind to Space Warp Assigns objects to be modified by a space 
warp.

Selection Filter drop-down list Limits the type of objects that can be selected.

Select Object (Q) Chooses an object.

Select by Name (H) Opens a dialog box for selecting objects by 
name.

   

 

Rectangular Selection Region, 
Circular Selection Region, Fence 
Selection Region, Lasso Selection 
Region, Paint Selection Region 
(Ctrl+F to cycle)

Determines the shape used for selecting 
objects in the viewport.

Window/Crossing Toggle Specifies whether an object must be crossed 
or windowed to be selected.

Select and Move (W) Selects an object and allows positional 
 translations.

Select and Rotate (E) Selects an object and allows rotational 
 transforms.
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Toolbar Button Name Description

  
Select and Uniform Scale, Select 
and Non-uniform Scale, Select 
and Squash (R to cycle)

Selects an object and allows scaling trans-
forms using different methods.

Reference Coordinate System 
drop-down list

Specifies the coordinate system used for 
transforms.

  
Use Pivot Point Center, Use 
Selection Center, Use Transform 
Coordinate Center

Specifies the center about which rotations and 
scaling are completed.

Select and Manipulate Selects an object and allows parameter 
manipulation via a manipulator.

Keyboard Shortcut Override 
Toggle

Allows keyboard shortcuts for the main inter-
face and the active dialog box or feature set 
to be used when enabled. Only main interface 
shortcuts are available when disabled.

  
Snap Toggle 2D, Snap Toggle 
2.5D, Snap Toggle 3D (S)

Specifies the snap mode. 2D snaps only to the 
active construction grid, 2.5D snaps to the 
construction grid or to geometry projected 
from the grid, and 3D snaps to anywhere in 3D 
space.

Angle Snap Toggle (A) Causes rotations to snap to specified angles.

Percent Snap (Shift+Ctrl+P) Causes scaling to snap to specified 
 percentages.

Spinner Snap Toggle Determines the amount a spinner value 
changes with each click.

Edit Named Selection Sets Opens a dialog box for creating and manag-
ing selection sets.

Named Selection Sets drop-down 
list

Lists and allows you to select a set of named 
objects.

Mirror Creates a mirrored copy of the selected 
object.

   

  

Align (Alt+A), Quick Align, Normal 
Align (Alt+N), Place Highlight, 
Align Camera, Align to View

Opens the alignment dialog box for position-
ing objects, allows objects to be aligned by 
their normals, determines the location of high-
lights, and aligns objects to a camera or view.

Manage Layers Opens the Layer Manager interface where you 
can work with layers.

Graphite Modeling Tools Opens the Graphite Modeling Tools panel.

continued
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TABLE 1.1 (continued)

Toolbar Button Name Description

Curve Editor (Open) Opens the Function Curves Editor.

Schematic View (Open) Opens the Schematic View window.

 
Compact Material Editor (M), 
Slate Material Editor (M)

Opens either the Compact Material Editor 
window or the Slate Material Editor window.

Render Setup (F10) Opens the Render Setup dialog box for set-
ting rendering options.

Rendered Frame Window Opens the Rendered Frame Window.

  
Render Production, Render 
Iterative, ActiveShade

Produces a quick test rendering of the current 
viewport without opening the Render Setup 
dialog box using the production settings, the 
iterative render mode, or the ActiveShade 
window.

Using the Modeling Ribbon
The Modeling Ribbon interface is a deluxe toolbar with many different tool sections. It currently is 
populated with a variety of modeling tools that are collectively called the Graphite Modeling Tools. 
You can turn the Modeling Ribbon on and off using the Graphite Modeling Tools button on the main 
toolbar. When enabled, tabs for the Graphite Modeling Tools, Freeform, Selection, and Object Paint are 
displayed.

fl Most Modeling Ribbon buttons are visible only when an Editable Poly object is selected. You can learn more 

about Editable Poly objects and the Graphite Modeling Tools in Chapter 11, “Modeling with Polygons,” and 

Chapter 12, “Using the Graphite Modeling Tools.”

Using the Minimize Ribbon button at the right end of the Ribbon, you can switch the display mode to 
minimize to only the tabs, only the panel titles, or only the panel buttons, or to enable the Minimize 
button to cycle through each of the modes. You also can double-click the Ribbon tabs to minimize the 
Ribbon or to cycle through the minimized modes.

Right-click the Ribbon title bar to access menu options to show or hide specific tabs or panels, cus-
tomize the ribbon, save or load a custom ribbon configuration, switch between horizontal and vertical 
orientations, reset the ribbon to its default, or enable tooltips. Figure 1.6 shows the different Ribbon 
display modes.

The entire Ribbon, as well as each individual panel of buttons, can be made into a floating control by 
dragging the Ribbon title bar or the lower panel bar away from the rest of the buttons. When a panel 
is made into a floating panel, like the one in Figure 1.7, the icons in the upper right of the floating 
panel let you return the panel to the Ribbon or toggle the orientation between vertical and horizon-
tal. You also can move the floating panel about by dragging on the gray bar on either side of the 
panel.
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FIGURE 1.6

The Ribbon can be set to be displayed using several different modes.

Minimize Ribbon buttonRibbon Tabs display mode

Panel Titles display mode

Panel Buttons display mode

Full Ribbon display mode

FIGURE 1.7

Ribbon panels can float independent of each other.

Return panel to Ribbon

Toggle Orientation

Using the Viewports
The four viewports make up the largest area of the entire interface and provide a way of viewing the 
objects within the scene. Each of the viewports is configurable and can be unique from the others.

fl Understanding how to work with the viewports is vital to accomplishing tasks with 3ds Max, so viewports 

have an entire chapter dedicated just to them—Chapter 2, “Controlling the Viewports.”
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Using the Command Panel
If there is one place in 3ds Max, besides the viewports, where you’ll spend all your time, it’s the 
Command Panel (at least until you’re comfortable enough with the quad menus). The Command Panel 
is located to the right of the viewports along the right edge of the interface. This is where all the spe-
cific parameters, settings, and controls are located. The Command Panel is split into six panels, each 
accessed via a tab icon located at its top. These six tabs are Create, Modify, Hierarchy, Motion, Display, 
and Utilities.

You can pull away the Command Panel from the right window edge as a floating dialog box, as shown 
in Figure 1.8, by clicking the open space to the right of the tabbed icons at the top of the Command 
Panel and dragging away from the interface edge. You also can dock it to the left window edge, which 
is really handy if you’re left-handed. While it’s a floating panel, you can resize the Command Panel by 
dragging on its edges or corners (but its width remains constant).

After you’ve pulled the Command Panel or any of the toolbars away from the interface, you can redock 
them to their last position by double-clicking their title bar. You also can right-click the title bar to 
access the pop-up menu of floating toolbars, but the pop-up menu also includes options to Dock 
(either Left or Right for the Command Panel or Left, Right, Top, or Bottom for toolbars), Float, and 
Minimize.

FIGURE 1.8

The Command Panel includes six separate panels accessed via tab icons.

Create

Modify

Hierarchy Motion

Display

Utilities

The right-click pop-up menu for the Command Panel also includes a Minimize command. If enabled, 
the Command Panel collapses to the edge of the interface, but moving the mouse near the interface 
where the Command Panel is minimized expands the Command Panel again. Moving the mouse away 
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from the Command Panel makes it collapse to the interface edge again. You can take the Command 
Panel out of Minimize mode by selecting one of the Dock commands.

Working with rollouts
Most of the controls, buttons, and parameters in the Command Panel are contained within sections 
called rollouts. A rollout is a grouping of controls positioned under a gray, boxed title, as shown in 
Figure 1.9. Each rollout title bar includes a plus or minus sign (a minus sign indicates that the rollout 
is open; a plus sign shows closed rollouts). Clicking the rollout title opens or closes the rollout. You 
also can reposition the order of the rollouts by dragging the rollout title and dropping it above or 
below the other rollouts.

NOTE

You cannot reposition some of the rollouts, such as the Object Type and the Name and Color rollouts, found in the Create 

panel.

FIGURE 1.9

Open and close rollouts by clicking the rollout title.

Opened rollout

Closed rollout

Right-clicking away from the buttons in a rollout presents a pop-up menu where you can select to 
close the rollout you’ve clicked in, Close All, Open All, or Reset Rollout Order. The pop-up menu also 
lists all available rollouts within the current panel with a check mark next to the ones that are open.

Expanding all the rollouts often exceeds the screen space allotted to the Command Panel. If the roll-
outs exceed the given space, then a small vertical scroll bar appears at the right edge of the Command 
Panel. You can drag this scroll bar to access the rollouts at the bottom of the Command Panel, or you 
can click away from the controls when a hand cursor appears. With the hand cursor, click and drag in 
either direction to scroll the Command Panel. You also can scroll the Command Panel with the scroll 
wheel on the mouse or by dragging with the middle mouse button.
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Increasing the Command Panel’s width
The Command Panel can be doubled or tripled (or any multiple, as long as you have room) in width by 
dragging its left edge toward the center of the interface. The width of the Command Panel is increased 
at the expense of the viewports. Figure 1.10 shows the Command Panel double its normal size.

FIGURE 1.10

Increase the width of the Command Panel by dragging its left edge.

Tutorial: Rearranging the interface for lefties
I used to work for a company that required that all computers have the mouse to the left of the key-
board. We swapped computers often, and the boss hated having to move the mouse to the other side 
of the keyboard (and you thought your work environment was weird). The reality is that some people 
like it on the left and others prefer it on the right, and 3ds Max can accommodate both.

With the Command Panel on the right side of the interface, the default interface obviously favors 
right-handers, but with the docking panels, you can quickly change it to be friendly to lefties.
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To rearrange the interface for lefties, follow these steps:

 1. Click the Command Panel on the empty space to the right of the last tab (the Utilities tab), 
and drag toward the center of the interface. As you drag the Command Panel away from the 
right edge, the cursor changes.

 2. Continue to drag the Command Panel to the left edge, and the cursor changes again to indi-
cate that it will be docked when released. Release the mouse button, and the Command 
Panel docks to the left side.

 3. For an even easier method, you can right-click the Command Panel’s title bar and select 
Dock ➪ Left from the pop-up menu.

Figure 1.11 shows the rearranged interface ready for all you southpaws.

TIP

If you’ve made changes to the interface that you want to keep, try saving a workspace using the Quick Access toolbar. 

Workspaces can be immediately recalled using the drop-down list. Workspaces are covered later in this chapter.

FIGURE 1.11

Left-handed users can move the Command Panel to the left side.
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Using the Lower Interface Bar Controls
The last major interface element isn’t really an interface element but just a collection of several sets of 
controls located along the bottom edge of the interface window. These controls cannot be pulled away 
from the interface like the main toolbar, but you can hide them using Expert Mode (Ctrl+X). These 
controls, shown in Figure 1.12, include the following, from left to right:

• Time Slider: The Time Slider, located under the viewports, enables you to quickly locate a 
specific animation frame. It spans the number of frames included in the current animation. 
Dragging the Time Slider moves you quickly between frames. Clicking the arrow buttons on 
either side of the Time Slider moves to the previous or next frame (or key).

• Track Bar: The Track Bar displays animation keys as color-coded rectangles with red for posi-
tional keys, green for rotational keys, and blue for scale keys. Parameter change keys are 
denoted by gray rectangles. Using the Track Bar, you can select, move, and delete animation 
keys. The button at the left end of the Track Bar is the Open Mini Curve Editor button. It pro-
vides access to the animation function curves.

• Status Bar: The Status Bar is below the Track Bar. It provides valuable information, such as 
the number and type of objects selected, transformation values, and grid size. It also includes 
the Selection Lock Toggle, Transform Type-In fields, and the value of the current Grid size.

• Prompt Line: The Prompt Line is text located at the bottom of the window. If you’re stuck as 
to what to do next, look at the Prompt Line for information on what 3ds Max expects. The 
Prompt Line also includes buttons for enabling Progressive Display and adding and editing 
Time Tags, which are used to name specific animation frames.

• Key Controls: These controls are for creating animation keys and include two different modes—
Auto Key (keyboard shortcut, N) and Set Key (keyboard shortcut, '). Auto Key mode sets keys for 
any changes made to the scene objects. Set Key mode gives you more precise control and sets 
keys for the selected filters only when you click the Set Keys button (keyboard shortcut, K).

• Time Controls: Resembling the controls on an audio or video device, the Time Controls offer 
an easy way to move through the various animation frames and keys. Based on the selected 
mode (keys or frames), the Time Controls can move among the first, previous, next, and last 
frames or keys.

• Viewport Navigation Controls: In the lower-right corner of the interface are the controls for 
manipulating the viewports. They enable you to zoom, pan, and rotate the active viewport’s view.

fl Most of the controls on the lower interface bar—including the Time Slider, the Track Bar, and the Key 

and Time Controls—deal with animation. You can learn more about these controls in Chapter 24, 

“Understanding Animation and Keyframes.” The Viewport Navigation Controls are covered in Chapter 2, 

“Controlling the Viewports.”

FIGURE 1.12

The lower interface bar includes several sets of controls.

Time Slider

Track Bar

Status Bar

Prompt Line

Key Controls Time Controls

Viewport
Navigation

Buttons
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Interacting with the Interface
Knowing where all the interface elements are located is only the start. 3ds Max includes several inter-
active features that make the interface work. Learning these features makes the difference between an 
interface that works for you and one that doesn’t.

Gaining quick access with the right-click quad menus
Quad menus are pop-up menus with up to four separate sections that surround the cursor, as shown in 
Figure 1.13. Right-clicking in the active viewport opens these quad menus. The contents of the menus 
depend on the object selected.

TIP

Many of the real pros use quad menus extensively. One reason is that they can access the commands from the mouse’s 

 current location using a couple of clicks without having to go all the way to the Command Panel to click a button.

FIGURE 1.13

Quad menus contain a host of commands in an easily accessible location.

Clicking with the left mouse button away from the quad menu closes it. For each menu, the text of the 
last menu item selected is displayed in blue. To quickly access the blue menu item again, simply click 
the gray-shaded bar for the quadrant that contains the blue menu item. Using Customize ➪ Customize 
User Interface, you can specify which commands appear on the quad menus, but the default options 
have just about everything you need.

If you press and hold the Alt, Ctrl, and Shift keys while right-clicking in the active viewport, you can 
access specific sets of commands; Shift+right-click opens the Snap options, Alt+right-click opens 
Animation commands, Ctrl+right-click opens a menu of primitives, Shift+Alt+right-click opens a menu 
of MassFx commands, and Ctrl+Alt+right-click opens a menu of rendering commands.

06_9781118328323-ch01.indd   3106_9781118328323-ch01.indd   31 7/30/12   10:20 PM7/30/12   10:20 PM



32

Part I: Getting Started with Autodesk 3ds Max 2013

Using Caddy controls
Quad menus are great for accessing specific commands, but changing the settings for the various fea-
tures still requires that you visit the Command Panel. This is where the Caddy controls help. Certain 
modeling features such as Bevel and Extrude let you open a select set of controls, known as a Caddy, 
overlaid over the selected object, as shown in Figure 1.14. Changing any of these settings updates the 
selection and lets you see if the change is what you want. If you’re happy with the setting, you can 
accept the change and dismiss the Caddy control.

A key benefit of the Caddy controls is that they stay near the selected subobject even if you change 
the viewport. In addition to several settings that are updated immediately, there are buttons to accept 
and commit the current change, to apply the change and continue to work with the tool, or to cancel. 
Using the Apply and Continue button keeps the tool around for more work.

FIGURE 1.14

Caddy controls appear above the selection and let you try several different settings.

Understanding the button color cues
The interface uses color cues to help remind you of the current mode. When a button is yellow, it warns 
that it has control of the interface. For example, if one of the subobject buttons in the Command Panel 
is selected, it turns yellow, and the ability to select another object is disabled until this subobject mode 
is turned off. Knowing what the current mode is at all times can keep you out of trouble.

Another common button color is red. When either the Auto Key or Set Key button is active, it turns 
red. The edge of the active viewport being animated along with the Time Slider also turns red. This 
reminds you that any modifications will be saved as a key.

Toggle buttons can be turned on and off. Example toggle buttons include the Snap buttons. When a 
toggle button is enabled, it also turns yellow (or light gray depending on the color scheme). Toggle 
buttons highlighted in blue are nonexclusive, but they notify you of a mode that is enabled, such as 
the Key Mode Toggle or the Affect Pivot Only button.
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Using drag-and-drop features
Dialog boxes that work with files benefit greatly from the software’s drag-and-drop features. The 
Material Editor, Background Image, View File, and Environmental Settings dialog boxes all use drag 
and drop. These dialog boxes let you select a file or a material and drag it on top of where you want to 
apply it. For example, with the Maps rollout in the Material Editor open, you can drag a texture image 
filename from Windows Explorer or the Asset Manager and drop it on the Map button. You can even 
drag and drop 3ds Max files from Windows Explorer into the interface to open them.

Controlling spinners
Spinners are those little controls throughout the interface with a value field and two small arrows to 
its right. As you would expect, clicking the up arrow increases the value and clicking the down arrow 
decreases the value. The amount of the increase or decrease depends on the setting in the General tab 
of the Preference Settings dialog box. Right-clicking the spinner resets the value to its lowest accept-
able value. Another way to control the spinner value is to click the arrows and drag with the mouse. 
Dragging up increases the value, and dragging down decreases it.

The effect of the spinner drag is shown in the viewport if the Update During Spinner Drag menu 
option is enabled in the Views menu. If the cursor is located within a spinner, you can press Ctrl+N to 
open the Numerical Expression Evaluator, which lets you set the value using an expression. For exam-
ple, you can set a spinner value by adding numbers together as you would if using a calculator. An 
expression of 30+40+35 sets the value to 105.

Understanding modeless and persistent dialog boxes
Many dialog boxes in 3ds Max are modeless, which means that the dialog box doesn’t need to be closed 
before you can work with objects in the background viewports. The Material Editor is an example of a 
modeless dialog box. With the Material Editor open, you can create, select, and transform objects in 
the background. Other modeless dialog boxes include the Material/Map Browser, the Render Scene dia-
log box, Caddy controls, the Video Post dialog box, the Transform Type-In dialog box, the Display and 
Selection Floaters, the Array dialog box and the various graph editors. Pressing the Ctrl+~ keyboard 
shortcut closes all open dialog boxes. Pressing the same keyboard shortcut again reopens the dialog 
boxes that were previously closed.

Another feature of many, but not all, dialog boxes is persistence, which means that values added to a 
dialog box remain set when the dialog box is reopened. This feature applies only within a given session. 
Choosing the File ➪ Reset command button or exiting and restarting 3ds Max resets all the dialog boxes.

Using Workspaces
If you’ve rearranged the various interface elements or customized different aspects of the interface, 
the Workspaces drop-down list located in the Quick Access toolbar at the top of the interface, lets you 
save the changes for quick recall. Workspaces let you create a unique interface environment for sev-
eral different tasks. For example, if you are modeling, you can create an interface with a double-wide 
control panel and another with the control panel hidden for animating.

NEW FEATURE

The ability to define and switch between workspaces is new to 3ds Max 2013.
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All the custom workspaces that are saved are available for instant recall in the Workspaces drop-down 
list. When 3ds Max is exited and reloaded, the last workspace that was open is automatically loaded. If 
you change a saved workspace, you can return it to its saved setting using the Reset to Default State 
menu also found in the drop-down list.

To save a custom interface setup, simply select the Manage Workspaces from the Workspace drop-down 
list and the dialog box shown in Figure 1.15 opens.

FIGURE 1.15

The Manage Workspaces dialog box lets you save custom interfaces for immediate recall.

All the current defined workspaces are shown in a list to the left of the Manage Workspaces dialog 
box. You can delete any defined workspace by clicking the red X next to it. Clicking the Save as New 
Workspace button opens another dialog box where you can enter the workspace’s name. For the 
selected workspace, you also can select which interface elements to include and even specify a 
MaxScript to run when the workspace loads or is exited.

Getting Help
If you get stuck, 3ds Max won’t leave you stranded. You can turn to several places in 3ds Max to get 
help. The Help menu is a valuable resource that provides access to references and tutorials. The 3ds 
Max Help and MAXScript Help are comprehensive help systems. They are HTML pages that are 
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accessible through the Autodesk.com website. Selecting Autodesk 3ds Max Help from the Help menu 
opens a web browser and loads the help files. This ensures that the latest and most up-to-date help 
files are available. Additional Help presents help systems for any external plug-ins that are loaded. 
The Tutorials command loads the tutorials, which offer a chance to gain valuable experience.

If you are working with 3ds Max offline, you can download and access a local copy of the help files. 
The Help panel in the Preference Settings dialog box, lets you specify whether to use the online or the 
local help files.

TIP

If you choose to use the online help files, you may find yourself waiting for the pages to load, which can be annoying if you 

are anxious to get an answer. I find that downloading and using a local copy is much quicker than the online version.

Using the InfoCenter toolbar
With all the various help files, sometimes it can be tough to know exactly which one to look in for the 
information you need. To help with this, 3ds Max includes an InfoCenter toolbar located at the right 
end of the title bar.

When you enter a keyword in the InfoCenter toolbar, 3ds Max performs a search and presents a list of 
information on where the keyword is found in all the various help files, including documentation and 
online resources.

TIP

You can use wildcards when searching for keywords. The asterisk (*) replaces one or more characters, the question mark (?) 

replaces a single character, and the tilde (~) looks for prefixes and/or suffixes added to the word. For example, con* finds 

controller, construct, and contour; sta? finds star and stat; ~lit finds prelit and relit; and limit~ finds limited and limitless.

Clicking the Search icon located to the right of the search text field (which looks like a tiny pair of 
binoculars) starts the search. The InfoCenter toolbar also includes buttons for accessing the 
Subscription Center, Communication Center, and Favorites. For each of these buttons, a pop-up dialog 
box appears that includes icon buttons in the upper right for closing the dialog box and for opening 
the InfoCenter Settings dialog box. The InfoCenter Settings dialog box includes settings for configur-
ing the Communication Center, which is a resource for getting information and announcements from 
Autodesk. You can configure the Communication Center to inform you when updates are available, dis-
play product support issues, and even include RSS feeds from Autodesk.

TIP

Within the InfoCenter Settings dialog box is an option to disable those annoying balloon notifications that frequently pop 

up, or you can make them semitransparent.

Viewing the Essential Skills Movies
When the software first loads, users are greeted with a Welcome to 3ds Max dialog box, shown in 
Figure 1.16, which includes several Essential Skills Movies. These simple movies explain the basics of 
working with 3ds Max.

06_9781118328323-ch01.indd   3506_9781118328323-ch01.indd   35 7/30/12   10:20 PM7/30/12   10:20 PM



36

Part I: Getting Started with Autodesk 3ds Max 2013

The Welcome to 3ds Max dialog box also includes links to What’s New and to the YouTube Learning 
Channel, which are pages where you can find more tutorials and resources. If you get tired of this 
appearing every time the software starts, you can disable the Show this dialog at startup option to 
prevent this dialog box from appearing the next time you start 3ds Max. You can access the Essential 
Skills Movies dialog box at any time using the Help menu. This dialog box is also helpful in that it 
presents buttons to create a new scene or open a file, and a list of recently opened files.

NOTE

The Essential Skills Movies require an installation of Flash.

FIGURE 1.16

The Welcome to 3ds Max dialog box includes video clips showing the basic skills you need for 
working with 3ds Max.

Using the online reference guides
Within the Help menu, the Autodesk 3ds Max Help, What’s New, MAXScript Help, and Tutorials are all 
loaded within a Web browser. An organized list of topics is available in the left navigation pane, as 
shown in Figure 1.17, and the right side includes a pane where the details on the selected topic are 
displayed. Across the top are several toolbar buttons used to control the interface. The Show in 
Contents button opens the selected help page in the Contents navigation list. The Add to Favorites 
button adds the current help page to the Favorites drop-down list accessible in the InfoCenter toolbar 
at the top of the interface. The Home: 3ds Max Help button returns to the first page of the Help file. 
The Share button lets you e-mail the selected page. The Back, Up, and Forward buttons move to the 
last, above, or previous page in the navigation.

TIP

You also can use the web browser buttons to move back and forth between the last-visited and next-visited pages.
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FIGURE 1.17

The 3ds Max Reference includes panels for viewing the index of commands and searching the 
 reference.

Show in Contents

Add to Favorites

Share

Home 

Above the left navigation pane are four tabs that open separate panels when selected. The Contents 
panel displays a list of topics; the Index panel lists all topics alphabetically, the Search panel includes 
a text field where you can search for specific keywords, and the Favorites panel keeps a list of book-
marks to topics you add to the list.

Throughout the textual descriptions, keywords linked to other related topics are highlighted in blue 
and underlined.

Using the rest of the Help menu
The Help ➪ Keyboard Shortcut Map displays an interactive interface for learning all the keyboard 
shortcuts. The Help ➪ Data Exchange Solutions menu opens a web page that explains how to use the 
FBX format to exchange files with other software packages. The Help ➪ Customer Involvement Program 
provides an interface where you can send feedback to Autodesk regarding 3ds Max. The program lets 
you send feedback anonymously or you can include your e-mail. If you notice a problem with the soft-
ware, you can report it with the Report a Problem feature. 
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The Help ➪ 3ds Max on the Web options (The AREA, Online Support, Updates, Resources, Partners, 
Training, and so on) automatically open a web browser and load the Autodesk Support web pages or 
look for updates. The AREA website is another excellent resource for help. It is the community site for 
3ds Max users.

TIP

If you need help from something more personable than a Help file, the AREA website is a 3ds Max community sponsored by 

Autodesk. It has some awesome help worth looking into.

The License Borrowing option lets you borrow and return the current license for use on another com-
puter. The About 3ds Max command opens the About 3ds Max dialog box, which displays the serial 
number, the version number and information about your license.

Summary
You should now be familiar with the interface elements for 3ds Max. Understanding the interface is 
one of the keys to success in using the software. 3ds Max includes a variety of different interface ele-
ments. Among the menus, toolbars, and keyboard shortcuts, you have several ways to perform the 
same command. Discover the method that works best for you.

This chapter covered the following topics:

• Learning the interface elements

• Viewing and using the pull-down menus

• Working with toolbars

• Accessing the Command Panel

• Learning the lower interface controls

• Interacting with the 3ds Max interface

• Managing workspaces

• Getting additional help

In this chapter, I’ve skirted about the viewports covering all the other interface elements, but in 
Chapter 2, you’re going to hit the viewports head-on.
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